Field Data Collection using SMART Mobile

Purpose
The purpose of this training resource is to provide a guide on how to collect field data using automated processes (SMART Mobile and CyberTracker). The intended target groups for training are field rangers, other frontline staff and ecological monitoring staff who work on site in terrestrial and marine protected areas, community conservancies, private reserves and other conservation areas.

Acknowledgements
The training handbook was prepared by the SMART Training Taskforce, a group of dedicated SMART users who work broadly across geographic regions, sites and situations where SMART is being implemented, in terrestrial and marine environments. The Training Taskforce is one working group under the SMART Partnership which currently comprises the following organizations: Frankfurt Zoological, Global Wildlife Conservation, North Carolina Zoo, Panthera, Peace Parks, Wildlife Protection Solutions, WCS, WWF, and ZSL.

Overview
This training resource covers the practical aspects of field data collection using patrol forms, navigation using GPS,
data recording on handheld devices using SMART Mobile in conjunction with configured data models, and data upload to SMART. The first section of the handbook introduces the rationale for law enforcement monitoring and the use of field patrol data for decision-making and adaptive management. The second section covers methods of data collection using logbooks, patrol forms, GPS, smartphones and SMART Mobile, and special applications (ecological monitoring and profiles data collection). Examples from some of the >1000 SMART implementation sites are used to provide context. In the final section, core tasks of the data collector for ensuring SMART data can be useful for adaptive management are presented.
TABLE OF CONTENTS

1 Introduction: the SMART Approach for Law Enforcement Monitoring (LEM)
   a Overview
   b What data to collect? Why?
   c What is the benefit of having geo-referenced data?
   d Importance of data management
   e Data quality and why it is important
   f Information needs for the implementing agency
   g Why SMART? Reasons for choosing SMART over other LEM monitoring tools
   h SMART Competences

2 Information needs and sources of data

3 How are field data collected for use with SMART?
   a Automated data collection using handheld devices
   b SMART Mobile and CyberTracker Classic - what is the difference?
   c Features of SMART Mobile

4 Installation and Use
   a Prerequisites
   b SMART Mobile setup
      a Prepare to install SMART Mobile
      b Prepare your SMART Connect for SMART Mobile
      c Setup in non-kiosk mode
      d SMART Mobile setup after installation to the device
      e Additional Configurable Model Features
   c Kiosk mode
      a How to enable kiosk mode
      b Setup for kiosk Mode
      c Provisioning the device
      d Exiting Kiosk Mode
   d Overlay of Internet Map Layers
   e Track timer settings
   f Creating a Package
   g SMART Mobile Desktop Simulator Instructions for Windows (64 Bit)
   h Preparing to record observations
   i Recording observations using SMART Mobile
   j Detailed Steps for Recording Observations using SMART Mobile
   k Groups
   l Signatures
   m Audio capture
   n Maps
a Manual GPS by dropping a point on the map
b Distance and Direction
c Offline maps
o Independent Incidents
p Mobile data export from device
q Importing SMART Mobile patrols into SMART
r Report bugs and other feedback on SMART Mobile
s Exporting patrol data for sharing
t Field exercise: Data collection using SMART Mobile equipped devices

5 Using SMART for adaptive management; tasks for the data collector
6 Features

7 Frequently Asked Questions
a On which types of patrols should there be data collection?
b Which observations should be recorded?
c What handheld devices/smartphones should we buy for our protected area?
d What should we do if SMART Mobile/CyberTracker device stops working during a patrol?
e What should we do if GPS battery dies?
f What should we do if we run out of datasheets?
g What should we do if the camera stops working/battery becomes flat?
h I'm running SMART on a Mac computer but cannot import patrols from CyberTracker, why?
i My Android device will not connect to my computer and I can't install CyberTracker/import patrols, what can I do?**
j Android settings and troubleshooting SMART Mobile

8 SMART Partners
Introduction: the SMART Approach for Law Enforcement Monitoring (LEM)

Overview
The SMART Approach for law enforcement monitoring involves a five-step process starting with the collection of field data by ranger patrols, through to decision-making and strategic planning (Fig. 1).

- **Ranger patrols** - Patrol teams collect and record data on where they go and what they see, such as human activities (e.g., signs of poaching, habitat encroachment, timber cutting), interventions (e.g., arrests, issuing of fines, confiscations of weapons and other restricted or banned equipment) and/or observations of wildlife and habitat features.

- **Data input** - Patrol teams report their patrol activities through a debrief, and patrol data and routes are checked for quality and/or errors and are then stored in the SMART patrol database.

- **Mapping and reporting** - Data are processed into highly visual tables, charts, and maps showing patrol effort, coverage and results, forming the basis for patrol analysis and evaluation.

- **Feedback and evaluation** - Regular meetings with rangers are held to discuss patrol effort, effectiveness and results to ensure all stakeholders are kept informed and to demonstrate the value of ranger efforts.

- **Strategic planning** - Managers, rangers, and other stakeholders plan adaptive patrol strategies based on analysis of previous results and set new patrol targets. These plans are communicated to the field staff and the cycle begins again.
What data to collect? Why?
Data collected by field teams should have inherent value for the management of the conservation area. Valuable data will include observations of wildlife, human activities (both legal and illegal), the condition of natural features, such as feeding, breeding and roosting areas, and movements and activities of patrol teams. Data must be recorded accurately and honestly so that decisions made on the basis of the observations are the most informed decisions possible.

What is the benefit of having geo-referenced data?
In order for managers to understand the distribution of threats and wildlife inside the conservation area, and where needed, direct field teams to take appropriate follow-up action, observations collected by patrol teams need to be geo-referenced. This means that each observation has a location and time attached to it that makes it possible to plot the observation onto digital maps of the conservation area. The quickest and most accurate way to do this is by using a dedicated Global Positioning System (GPS) device or a handheld device with GPS function. As such, the GPS is an important tool for information or intelligence-led patrolling.

Importance of data management
Increasing threats to wildlife and habitats puts increasing pressure on managers to respond with the right decisions.
in a time efficient manner. Ranger teams need to be deployed to threat hotspots so they can arrest poachers, detect snares and traps and prevent wildlife crime from happening thus, saving the lives of animals. To ensure this happens, accurate and honest data should be recorded by rangers in the field, and this data needs to be turned into information in as close to real-time as possible. Patrol data may not be the only kind of data used to make decisions (see below).

Data quality and why it is important
Rangers and other field staff play a primary role in ensuring good quality data are collected in the field (Fig. 2). Only good quality data can be included in basic analyses (queries and summaries) and reports to management. Rangers may need to verify the locations and times of observations of human activities recorded by patrols, and confirm any unusual observations, such as records of endangered species, or details of enforcement interventions, infractions recorded and actions taken. Poor quality data should be addressed by conducting training or refresher training as needed, to upgrade skills and by using various approaches to motivate rangers to achieve a higher level of performance.

Fig. 2. Decisions made using data will only be as good as the data that has been collected.

Information needs for the implementing agency
At the time of writing, nearly 1,000 sites in more than 65 countries are involved in SMART deployments. This includes 16 countries which have adopted SMART as a national monitoring system for their protected areas. More than 115 government agencies are currently involved in these deployments. Each agency has its own needs for information that can help with effective park protection and management, monitoring of endangered species and threats. For example, managers of national parks and marine protected areas require information on human impact in order to implement plans for managing recreation areas and other managed use zones. Wildlife sanctuaries and game reserves are set up to protect focal species, so managers require information on the distribution of those species and the spatial and temporal distribution of threats to wildlife and their habitats. Community conservancies are established to manage human use of lands, so managers need to assess impacts on natural resources that may be used by local people.
Why SMART? Reasons for choosing SMART over other LEM monitoring tools

SMART is the world’s leading tool for conservation law enforcement monitoring (LEM) and protected area management¹. SMART LEM enables the collection, storage, communication, and evaluation of data on patrol efforts, patrol results, and threat levels, along with feedback from decision-makers to the frontline. Data collection is possible through the use of paper forms plus GPS, or via handheld digital devices. Available in multiple languages, data analysis is facilitated by an easy-to-use query wizard (see: SMART Essentials Training Handbook, page 59). Implementation of SMART LEM can enhance law enforcement effectiveness, improve morale of protection teams, and reduce threats to wildlife and other natural resources at numerous sites across the world¹. When effectively employed, to create and sustain information flow between rangers and conservation managers as part of the SMART Approach, SMART LEM can be used to substantially improve protection of wildlife and their habitats.

Ranger Enkchimeg in the Mongolian Gobi desert

SMART Competences

The ability to use the SMART tools for collecting and managing field patrol or survey data falls under two competence categories; Development, Deployment and Management of SMART (DDM), and Field Data Collection (FDC). These competences would be needed by middle managers/technical experts and skilled workers. In this manual specific SMART competences² relevant to the tasks described are indicated for each subheading. These include

DDM 2.6 Set up field devices for collecting SMART data

DDM 2.7 Integrating new technologies for data collection into the SMART system

DDM 2.8 Collate and manage data collected in the field

DDM 3.1 Direct installation and setup of hardware and software required for SMART

DDM 3.2 Direct set up and customization of SMART according to specified requirements
DDM 3.3 Direct development of standard data collection protocols compliant with SMART

FDC 1.1 Correctly identify and classify observations required for entry into the SMART system

FDC 1.2 Correctly enter data/information into devices configured for SMART data collection

FDC 1.6 Ensure that data collected in the field is correctly submitted

FDC 2.1 Plan and lead practical field data collection using SMART

FDC 2.3 Lead data collection in the field
**Information needs and sources of data**

To ensure effective planning and management, managers need to be able to come up with answers for a range of questions about conservation areas:

- What are the threats?
- Which species are currently at risk to threats, such as poaching?
- Which species may be at risk in the near future?
- Where are the problem areas?
- What resources are available for protection activities?
- Where have patrols happened and where are the gaps in patrol efforts?
- Are threats increasing or decreasing over time?
- Are patrols effective? Are we achieving the aim of protection?

**NOTE**

Data useful for answering such questions will come from various sources. Including, but not limited to:

- **Patrol data.** Field patrols conducted by law enforcement staff and community rangers produce data on human activities, especially those that pose a threat to the conservation area, data on area coverage and presence as well as data such as resource use (e.g. vehicles, stations) and workforce hours spent in the field. They may also collect vital information on the wildlife or other resources protected by the conservation area.

- **Intelligence.** Surveillance conducted by special monitoring and investigation teams, informants, and wildlife crime hotlines produce data useful for creating intelligence records and networks on wildlife crime and other illegal activity.

- **Incidental records.** Reports from other sources, such as community members, tourists and/or tour operators, produce data on observations of rare or endangered species and human activities, including marked animals or individuals of special interest.

- **Special events.** Data collected by camera-traps, acoustic devices and drones may produce useable records about human or wildlife activity and movement.
There are two broad categories of data collection: manual data collection, involving filling in of paper forms together with a GPS device, and automated data collection, involving use of handheld electronic devices such as PDAs, tablets and smartphones (Fig. 3). Both are designed to help rangers collect information in a standardised way. This allows information collected over time, or by different observers, to be comparable, which is a critical factor in studies employing many field rangers or field staff. Each approach has its advantages and disadvantages that need to be evaluated when considering which particular method to employ in a conservation area. For the purposes of this handbook, we will focus instruction on automated data collection using SMART Mobile. (For further information about manual data collection using SMART please see: SMART Technical Training Manual: Module 3: Patrols).

Automated data collection using handheld devices

Handheld devices such as PDAs, tablets and smartphones may further simplify and speed up the process of data collection and transfer when used in conjunction with SMART Mobile or CyberTracker Classic, an application for the collection and visualization of field data. SMART Mobile and CyberTracker currently run off of the Android Operating System (OS), with plans for an Apple iOS version in the near future. CyberTracker Classic remains available on Windows Mobile.

Important: The desktop application of CyberTracker is only available for the Windows OS, meaning that the import or export of Patrol/Survey Configurable Models or data collected from the field cannot be currently done on a Mac OS or Apple computer not running Windows.
SMART Mobile/CyberTracker are used to record observations based on a configured version of your SMART data model (see: SMART Technical Training Manual: Module 9: CyberTracker Plug-In and Smart Mobile). GPS waypoint and tracklog and observation data are collected simultaneously and uploaded to SMART in a semi-automated process (see details in section 3.3.4 below).

SMART Mobile and CyberTracker Classic - what is the difference?
SMART Mobile is powered by CyberTracker (CT), offering functionality and user experience enhancements specifically requested by the SMART user community, as well as much tighter integration with the SMART desktop software and SMART Connect. SMART Mobile uses a GPS-enabled mobile device to collect both observations (text and/or icon-based data entry and digital images) and GPS data in a single unit. Patrols and observations can then be transferred directly into SMART desktop by connecting the device, or remotely through SMART Connect (see: SMART Technical Training Manual: Module 13: Connect Plug-in) in semi-automated processes.

Features of SMART Mobile
Modern easy to use user interface SMART Mobile has a modern easy to use user interface:

Modern easy to use user interface
SMART Mobile has a modern easy to use user interface:

Support for more environments

Fig. 4a. The user interface includes smooth scrolling, easy to use lists and high-resolution icons.
Modern state of the art mapping  The state-of-the-art mapping in SMART Mobile, includes the ability to complement online base maps with offline maps generated directly from SMART desktop:

Fig. 5. Pinch-zoom, map rotation and navigation.

Navigation to previous observations  Includes detailed sighting history views. This feature turns SMART mobile into a functional navigation device:
Fig. 6. View your sighting history in the field, individual sightings can be edited without disrupting patrols/surveys & supports users to navigate to previously visited locations.

**Other mapping features**

- Sightings, Incidents, Tracks are visible
- Offline maps overlaid on base map
- 10 online base maps: OpenStreetMap, National Geographic, Satellite, Oceans, etc.
- Offline mode where no basemap is required
- Layers can be turned on and off
- Inspect
- Navigation with realtime pointer
- Compass
- Detailed data
- Satellite view
- Smooth panning, pinch–zoom and rotation
- Rotate to north at top button
- Zoom in, zoom out buttons
- Follow modes: user, follow, navigation
- Co-ordinates in decimal degrees, degrees minutes seconds, degrees decimal minutes and UTM

**Multi-leg patrols** Patrol type can now be changed while the patrol is in progress. Also, patrols can now be easily paused and resumed. When paused the track timer is disconnected, ensuring that SMART delivers an even more accurate measure of effort:
Desktop demo version for training SMART Mobile also has a desktop demo version for Windows which works exactly the same as the mobile version that can be used for training. The GPS simulation can be customized for your location as part of the training.

Robust kiosk mode SMART Mobile supports a robust kiosk mode that locks the device for use only by SMART Mobile. Kiosk mode can be exited with a preconfigured pin.

Simple, Customizable, Themes Ability to customize the look and appearance of SMART Mobile from within SMART selecting theme colors and your own project icon.

Independent incidents during patrols/surveys During or outside of a patrol or survey, observations can be recorded independently from a patrol or survey. These observations are recorded as independent incidents in SMART:
Fig. 8. If you are collecting ecological records data on a mission but have a protocol of recording human-wildlife conflict or poaching signs independently, b) you can now easily record these as independent incidents without interrupting your overall data collection.
Installation and Use

Prerequisites
To use SMART Mobile:

- You must have installed SMART Desktop version 7.5 or higher (earlier versions are not supported).
- Android version 6.0 or higher: you can view what Android version you have in the device’s System Settings.
- iOS version 14.x for SMART Connect only. This makes use of wireless connectivity, uploading configurable models via the SMART Connect server. For iOS on your device go to Settings > General > About.
- If you use SMART Connect, you will need SMART Connect version 6.3 or higher (earlier versions are not supported).
- You must decide whether you want to use the kiosk mode version or the non-kiosk mode version of SMART Mobile (see below).

IMPORTANT
SMART Mobile is available in a kiosk mode version for Android devices. This version needs to be specifically chosen and requires additional steps to set up so it is imperative that you decide whether or not this is necessary before selecting the version of SMART Mobile you plan to use (e.g. kiosk vs. non-kiosk).

SMART Mobile setup

NOTE
If you decide to use kiosk-mode please navigate to setup instructions for kiosk mode. The following instructions are for the non-kiosk version of SMART Mobile.

Prepare to install SMART Mobile
Before you install SMART Mobile on an android device you need to prepare your android handheld device. On your Android handheld device, you need to:

1. Have a file manager: Any file application, pre-installed or downloaded, that allow one to browse folders on the device should work.
2. Enable “Use Unknown Sources”
   - From a Home screen, swipe up or down from the center of the display to access the apps screen.
3. Navigate: Settings > Apps
4. Tap Menu icon (upper-right)
5. Tap Special access
6. Tap Install unknown apps
7. Select the unknown app then tap the Allow from this source switch to turn on
   - Set the location mode to device only
If you ARE using SMART Connect, proceed to 4.2.2. If you ARE NOT using SMART Connect at your site, proceed to 4.2.3.

Prepare your SMART Connect for SMART Mobile

1. Sync all your desktop and Connect SMART instances and all local data on your desktop is synced with your Connect instance.
2. Backup your existing SMART desktop database.
3. Backup your existing SMART desktop database using the File > Backup System menu option.

WARNING
To avoid losing data, before making any changes to SMART, always sync your desktop and make a backup of your Conservation Area.

Setup in non-kiosk mode

You will set up your device with SMART mobile then learn the procedures for using the app to collect observational data.

A. Uninstall any previous version of SMART Mobile (if applicable).

B. Download the latest SMART Mobile application file from the SMART website – www.smartconservationtools.org.

C. Save the .APK file in an easily found location on your computer (e.g., the same root folder as your SMART Desktop installation). Connect your mobile device to your computer. In SMART Desktop, go to Field Data > SMART Mobile > Install SMART Mobile on Device...

HINT
SMART Mobile is continually improving. Newer builds may be released with bug fixes and other improvements. When possible, use the latest build.

NOTE
This wizard will overwrite the existing APK on your device with the most current version. (Fig. 11)
D. Click the “…” button and browse to the folder where you saved the APK file and select it and click Next.

E. Select the option Copy SMART Mobile to Device.

F. Click Next
G. Select the device you would like to export to. If the device is not shown check that it is in file transfer mode and refresh the list. Always select **internal storage** if given the option of SD card. Ensure to de-select SD card option.

H. Click **Copy application to selected devices**. This ends the desktop setup, now go and check your device for the SMART Mobile application.
I. Now looking at your device, install the SMART Mobile Application (see screenshot examples below)

1. On your Android device, use the file manager to find the SMART Mobile APK file.
2. Select the SMART Mobile APK file to launch the installation.
3. Select **Install**
4. Once the installation has finished, select **Done**.
5. You will be prompted to “delete the installation package”. Click **Yes**.
J. You may be prompted to switch your Android device’s home launcher app to SMART. **If you receive this message, do [NOT] select switch launcher apps.** (Note: This prompt may be different on your device.)
Select a Home app

- Launcher3
- SMART Mobile

JUST ONCE   ALWAYS

K. Launch SMART Mobile
Choose a configurable model for data collection

Depending on the mandate for the patrol, you will select a data model for use with collecting data. The data model will include relevant categories and attributes of data that are to be collected. Designing data models is a topic for advanced administration. Here we will simply take a look at the configurable model and see what it contains.

Reminder: The Data Model for a Conservation Area is made up of all the possible categories and attributes you may want to record when making an observation. A Configurable Model is how the Data Model can be edited to appear for different patrol mandates, i.e. law enforcement, research or wildlife monitoring. For more information, see: [SMART 6 Technical Training Manual,] Module 9: Data Model Management

SMART Mobile setup after installation to the device

Choose a configurable model for data collection

Depending on the mandate for the patrol, you will select a data model for use with collecting data. The data model will include relevant categories and attributes of data that are to be collected. Designing data models is a topic for advanced administration. Here we will simply take a look at the configurable model and see what it contains.

Reminder: The Data Model for a Conservation Area is made up of all the possible categories and attributes you may want to record when making an observation. A Configurable Model is how the Data Model can be edited to appear for different patrol mandates, i.e. law enforcement, research or wildlife monitoring. For more information, see: [SMART 6 Technical Training Manual,] Module 9: Data Model Management

1. From SMART Desktop Select Conservation Area > Configurable model > ‘Name of model’.
2. Click edit to inspect the categories and attributes associated with the model
3. Check to make sure the SMART Mobile settings follow what you see below by selecting ‘Field Data- >CyberTracker Classic->CyberTracker Properties’ in SMART.
4. Kiosk Mode on or off as per choice made in Section 4.1 above
5. Track Timer can be between 3 and 10 secs
6. Set GMT/UTC time offset for your location
7. If you make any edits to the settings, make sure to select Save

NOTE
For SMART 7 these configurations apply to both SMART Mobile and Cybertracker Classic. You will configure
CyberTracker Default Properties

Default properties that will be applied to all created CyberTracker applications

Profile Name: **Default**

<table>
<thead>
<tr>
<th>Property</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Title Bar</td>
<td></td>
</tr>
<tr>
<td>Large Titles</td>
<td>✔</td>
</tr>
<tr>
<td>Large Scroll Bars</td>
<td>✔</td>
</tr>
<tr>
<td>Large Tabs</td>
<td></td>
</tr>
<tr>
<td>Auto Radio Next</td>
<td></td>
</tr>
<tr>
<td>Allow Viewing of Collected Data</td>
<td>✔</td>
</tr>
<tr>
<td>Show GPS</td>
<td>✔</td>
</tr>
<tr>
<td>Kiosk Mode</td>
<td>✔</td>
</tr>
<tr>
<td>Simple Camera</td>
<td></td>
</tr>
<tr>
<td>Can Pause</td>
<td>✔</td>
</tr>
<tr>
<td>Disable Editing</td>
<td>✔</td>
</tr>
<tr>
<td>Use SD Card for Data Backup</td>
<td></td>
</tr>
<tr>
<td>Test Time on Startup</td>
<td></td>
</tr>
<tr>
<td>Reset to Start Screen on Upload</td>
<td></td>
</tr>
<tr>
<td>Reset Screen on Next</td>
<td>✔</td>
</tr>
<tr>
<td>Kiosk Mode Exit Pin</td>
<td>1234</td>
</tr>
<tr>
<td>Maximum Photos per Observation</td>
<td>5</td>
</tr>
</tbody>
</table>

Close | Save
SMART Mobile, unlike Classic CyberTracker, is capable of rendering any Unicode language as text on the device. In order to do this, you need to edit the text of your configurable model. Open a configurable model, select **Edit** and select all the categories and attributes, one-by-one, and simply type in whatever language you want displayed on the device.

**Additional Configurable Model Features**

**Language**

SMART Mobile, unlike Classic CyberTracker, is capable of rendering any Unicode language as text on the device. In order to do this, you need to edit the text of your configurable model. Open a configurable model, select **Edit** and select all the categories and attributes, one-by-one, and simply type in whatever language you want displayed on the device.
Icons

Creating and exporting configurable models to SMART Mobile is much the same as for CyberTracker Classic. However, SMART Mobile enables the use of icons which display on the device instead of, or alongside, text in order to assist in cases where field staff are unable to read the instructions or work better with images. In order to enable these on your device you need to edit your configurable model.

In SMART Mobile version 3xx there are an additional yy icons available to choose from.

Locate the configurable model you plan to export to your device and select Edit. For each group, category and attribute you are able to decide whether you want to display text, image or both text and image. SMART comes pre-loaded with a set of icons for the default data model. If your data model uses the same category you can simply use “Image: Data Model (Default Image)”. If your data model does not have a default image (or you would prefer a different icon) you can do this by selecting “Custom” under “Image”. You can then select an icon from your hard drive (or select another built-in SMART icon) and associate this with your group, category or attribute.
Once you’re happy with the structure and design of your configurable model click Save.

Kiosk mode

Kiosk mode is a function which locks your device to the function of a specific application and prevents the use of any other application. Essentially, using kiosk mode will turn your device into a SMART-Mobile-Only device.

When to use kiosk mode

Deciding whether to use kiosk mode is highly dependent on your particular use case. If you feel it is necessary to lock a device to SMART Mobile only then kiosk mode is for you. This might be to ensure that devices procured for SMART data collection are used only for this function and nothing else. By dedicating your mobile device for SMART mobile data collection, kiosk mode simplifies data collection, focuses attention on that task alone, and conserves device resources.

When not to use kiosk mode

If you or your field team need to use other functionality on data collection devices, then kiosk mode is not required. Other apps that may be used in the field include telephone function or communication applications, additional navigation applications, specific camera applications, and others (note: SMART Mobile does record track data and images). If your field teams do not need these other applications, then you may want to consider using kiosk mode.

How to enable kiosk mode
Once you have made a decision about whether or not to use kiosk mode, you must make a change in the SMART Conservation Area (CA) on your computer in the settings for your configurable model.

Login into your SMART CA then go to Conservation Area > Configurable Model.

- Select the model you wish to use from the list

- Select **Edit** and go to the **CyberTracker** properties tab

- Select **Edit profile** and check/uncheck the **Kiosk mode** box

- **Save** the change
Setup for kiosk Mode

1. In SMART Desktop, go to Field Data > SMART Mobile > Install SMART Mobile on Device...

2. Click the “...” button and browse to the folder where you saved the .APK file and select it and click Next.

3. Select the option Configure SMART Mobile as a kiosk.

4. Click Next.
5 Click Next

6 Now you must install the driver which allows this computer to install kiosk mode onto your device. Select **install / reinstall driver**.

7 Right click on “android_winusb” (file type: Setup Information) and select **install**.
8 Click Next

Provisioning the device

1 Factory reset the device by opening settings on your device and selecting “Factory Data Reset”.
2 Wait for the device to restart
3 Follow the instructions and press skip when asked to create an account.
4. Change the time and date back to the correct date and time using the settings on the device.

5. Change the GPS settings in **location** to use GPS only.

6. Enable “Developer Mode” > **About phone > software information** and tap on the build number (or version) 10 times to access **developer mode**.
Enable "USB debugging" by opening the settings, search for USB debugging under developer options and toggle this on.

Connect your device to your computer – select “allow USB debugging” if prompted and select OK.

Configure your device by selecting “Provision the device”.

Click Finish.
Once your mobile device has been configured for kiosk mode, you can only exit out of kiosk mode by:

- Typing in your pin; or
- Factory resetting the device

Overlay of Internet Map Layers

WMS layers can be configured in the “Basemap Settings” under the package. There are many public layers available, for example:

- https://nowcoast.noaa.gov/arcgis/services/nowcoast/radar_meteo_imagery_nexrad_time/MapServer/WMSServer
The desktop can configure different track timer settings for each patrol type. The value of this setting can be seen on the map screen:

### Creating a Package

Now that you have created your configurable model that can be used to efficiently collect your data, you can export your Data Collection Package from your SMART desktop to your mobile device as follows:

[There are two options, manual export via a USB connection, or download direct from SMART connect]
Manual export via USB connection

1. Open your SMART database.
2. Connect your mobile device to your computer USB port using the device's download cable.
3. Make sure the device is connected for ‘file transfer’.
4. Export the configurable model you will be using by clicking, “Field Data->SMART Mobile->Packages”... and then on the SMART Mobile Packages dialog that allows you to export either Local or Connect packages click on +Add and select Patrol Package as your SMART Mobile Package Type.

5. Set “Export Location” as “Device”.
7. Select your preferred basemap (Leave min/max at the defaults, and lower the “Max” to number (e.g., to 1 or 2) to speed up the export).
8. Check Collect Independent Incidents and select your Configurable Model an Independent Incident Model if you wish to enable this option.
9. Click “Export...”
10 Disconnect the device.

11 Open SMART Mobile on your device.

12 Click **SMART Mobile** on the **Connect** screen. This will scan your device for new projects. Your configurable model should autoload in the **Projects** screen and be ready for use.
NOTE

When updating a configurable model (for example to add new employees added to list) and needing to update the devices, if it is the same patrol package name, SMART Mobile will overwrite it. Just go through the same workflow as before to export the configurable model to the device.

SMART Mobile Desktop Simulator Instructions for Windows (64 Bit)

The SMART Mobile simulator runs on Windows desktop and is intended to help with training and testing. To get started, follow the following steps:

1. Download the zipped SMART Mobile simulator program files
2. The SMART Mobile desktop simulator is available at www.smartconservationtools.org
3. Extract the files to a local folder on your computer.
4. Open SMART desktop and export a Patrol Package to file:
   - When exporting to a file, set the file location to "C:\users\<YourName>\Downloads" or "C:\users\<YourName>\Desktop", being sure to replace <YourName> with whatever your local user name on the machine is.
   - The file name is not important, as long as it ends in .zip. When the desktop simulator processes the file, it will remove it from the directory.
   - The exported file MUST have a ZIP extension
Navigate to the location where you extracted the SMART Mobile simulator program files and open the executable file (SMART-Mobile.exe).
The simulator will open as it would display on a mobile device.

6. The simulator will open as it would display on a mobile device.

7. Click on the configurable model and run SMART Mobile on the desktop.

Preparing to record observations

1. Turn on the SMART Mobile-equipped device.
2. Turn on the GPS on the device.
3. Start the SMART Mobile application by tapping on the SMART Mobile icon on your home screen:

4. Tap on the configurable model for the field activity you want to undertake.

NOTE
SMART Mobile can accommodate multiple configurable models for example for different patrol mandates or objectives. In the example below the device can be used either for recording law enforcement or wildlife patrols, each with its own unique configuration.

If you need to exit from SMART Mobile after you have selected the configurable model enter the default exit pin code...
“1234” and press the green button, or have your SMART data manager enter the correct pin code. See SMART Technical Training Manual: Module 9: CyberTracker Plug-In and Smart Mobile* for more details on pin codes and ‘Kiosk mode’.

After selecting the configurable model, you are ready to begin recording the Patrol Configuration

1. Select Start Patrol then you will see a screen to enter the patrol configuration
2. The GPS automatically starts to look for satellites and will return the location after achieving a 3D fix
   - SMART Mobile will not allow a patrol to start until it has gotten a location (i.e., you will see coordinate in the “Location” box). This may take a few minutes if the device is new and getting a GPS location for the first time or hasn’t been used recently.
3 Use the dropdown menus to select the associated metadata:
   - patrol transport type
   - armed status
   - team name
   - station name
   - patrol mandate
4 First select values for patrol transport type
5 Then select the team name
6 Then select the station name
Then select the **Patrol Mandate**. This will correspond with the configured data model being used.

For **Employees** scroll down the list and check the boxes next to the names of staff participating in the patrol.

Select the **Leader** by highlighting his/her name, then click the arrow in the upper left of the screen to go back to the Employees menu, then check the tick box in the upper right of the screen:

If you want to specify objectives or comments those will require entering text into the relevant fields, then check the tick box in the top right of the screen:
When you are finished entering the patrol configuration check the tick box in the top right of the screen. This will take you to the Patrol screen from where you can begin to record observations:
Recording observations using SMART Mobile

From the patrol screen you may end, pause or change your patrol, simply select “Patrol” to enter the menu at the bottom of your screen.

You should select **Pause patrol** when the team is not actively engaged in search activity for example when taking a meal break, when waiting for radio orders from a patrol supervisor, or if a vehicle is broken down. You can only pause a patrol if you checked the pause patrol box in the Cybertracker settings. Hit **Pause patrol** again to restart the patrol after it was paused.

**NOTE**
The ‘Pause Patrol’ function must be enabled in the CyberTracker properties for it to be visible on patrol (See Section 4.2.5 – above).
You may want to change the transport type, mandate, employees or leader during the patrol as the situation requires. A significant enhancement in SMART Mobile is the ability to change patrol metadata during the patrol. For example, if your patrol began as a foot patrol and later continued by vehicle, you would use this function to change your patrol transport type from "foot" to "vehicle" with the ease of a few taps, rather than having to end and restart your patrol with different data. The device will make a note of when and where this occurred for more accurate information on your patrols. Once you download the data to SMART, the different sections of the patrol will automatically display as different patrol legs.

You would select **End patrol** after you have completed your patrol route, have returned to your station or have stopped recording observations and do not plan to resume again for the rest of the day or evening.
During a patrol you can also access the following functions:

1. **Map**: Check your GPS location while on patrol and view observation locations and the tracklog.
2. **History**: Check the observations that were recorded during the patrol.
3. **See individual observations, times & dates.**
Detailed Steps for Recording Observations using SMART Mobile

Select ‘Make observation’ at the top of the screen to record patrol observations (below a) relating to SMART data model categories (wildlife, human activities, features and patrol movements etc). In the example below an observation of human activity is recorded b) then details of people encountered is recorded c) along with a photo d).

To finish entering data for an observation select the tick box at the top right of the screen (see red box in top-right of d below). Once the observation has been recorded, save the incident selecting the green button at the bottom right of the screen (below e).
**Multiple observations** can be made at each location (incident). Each time a new observation is added select ‘Make Observation’.

In the example below, a [person] was encountered at a [camp] with a [wildlife carcass]. This represents three
unique pieces of data (observations) at one location/event (incident) that should be collected as part of the data model. To begin, the observer first enters the relevant details for the person (below a-d) and clicks on the white check in the top right of the screen (below d). This completes the data entry for Observation #1 (the person) at the incident. The observer would then go through the process again for both the camp (e-h) and the carcass (i-l), making sure that each time the relevant details of the observation are recorded. After entering all of the relevant data for each observation and ticking the white check at the top of the screen, the observation will appear in list of observations recorded at that incident (below m). Note, that below in (m), both ‘Camp’ and “Carcass” appear beneath “People – direct observation”. Once all observations have been recorded at the incident, save the incident selecting the green button at the bottom right of the screen (below m).
Groups

Groups allow input of grouped observations at a single point. This is available when:
"Incident Group UI" is enabled in the Device Settings

Signatures
Signature fields must be configured on SMART desktop. This is what it looks like on Mobile:

Audio capture
If attachments are allowed for a category, then you will be able to add one or more pictures and an audio note:
Maps

SMART mobile allows you to use your device for navigation with a multi-featured map:

- Sightings, Incidents, Tracks are visible
- Offline maps overlaid on base map
- 10 online base maps: OpenStreetMap, National Geographic, Satellite, Oceans, etc.
- Offline mode where no basemap is required
- Layers can be turned on and off
- Inspect
- Navigation with realtime pointer
- Compass
- Detailed data
- Satellite view
- Smooth panning, pinch-zoom and rotation
- Rotate to north at top button
- Zoom in, zoom out buttons
- Follow modes: user, follow, navigation
- Co-ordinates in decimal degrees, degrees minutes seconds, degrees decimal minutes and UTM
- Manual GPS by dropping a point on the map
- Distance and direction

Manual GPS by dropping a point on the map

The location can be set manually by long pressing on the map. This is available when:

- “Use instantaneous GPS points” is enabled in the Configurable Model settings
“Manual GPS on skip via input” is enabled in the Device Settings. This means you do not need to be standing in the same location as the point you want to record:

Distance and Direction
Sighting distance and direction can be set when:

- “Record Distance (m) and Bearing (degrees)” is enabled in the Data Collection Options dialog
Offline maps

By default, the “SMART Basemap” feature generates an offline map based on the map in SMART. If this is not sufficient, custom offline maps can be added to the SMART Mobile Package. SMART Mobile supports MapBox (.mbtiles) and ArcGIS (.tpk, .vtpk) offline maps. To enable them, on the Package dialog, select the “Basemap Settings” tab, then add layers from your machine.

During the next package upload, these files will be available via the Layers menu (bottom left):
**Independent Incidents**

SMART Mobile allows you to collect data not associated with a patrol, on a handheld device. To use this feature, you will need to install the ‘Independent Incident’ plugin to your SMART database via the ‘File \Install New Plugins’ menu. Once you have done this, you can re-export your patrol package and select a configurable model to be used for independent incidents which can differ from your chosen patrol model. For more information on independent incidents see: [SMART 6 Technical Training Manual] Module 11: Independent Incident Plug-in.

**Mobile data export from device**

To export data collected from SMART Mobile to your computer:

1. Click “Export Data” in SMART Mobile
2. SMART Mobile will create one or more JSON files for each project and place it in a new folder called “/SMARTdata”
It is not necessary to use SMART mobile in a connected environment. SMART mobile data collection can be done outside of telephone 3G or 4G networks. However, if you are using SMART Connect with the data queue wifi settings enabled (see the Advanced Administration with SMART connect training handbook) simply ending your patrol will send data to the data queue which can be downloaded directly into SMART desktop.

For offline use, to import the data collected in SMART Mobile directly to SMART Desktop:

1. Connect your mobile device to your computer using the cable
2. Make sure device is connected for ‘file transfer’
3. Open SMART Desktop and go to Field Data>SMART Mobile>Import…
4. Select to Import From your Device and SMART will automatically pull your data from your device.
5. Alternatively you can transfer the data from the SMARTDATA folder on the device to a folder on the desktop, and from there Import from Files to SMART. Click the Green cross and select the file to import.
The SMART Mobile app you are using is a public release version. It has already received extensive field use and testing, however, there remains the possibility of glitches. Please report all bugs and any general comments (e.g., “Feels like too many clicks to get from X to Y”) about your experience using SMART Mobile following the steps below. This will ensure we efficiently address all comments/concerns to improve SMART Mobile.

Compile the relevant details about the bug reported or your user experience feedback in an email:

1. In the **Subject** of the email:
   - Enter a short description of the bug or feedback.
Creating a bug report in SMART Mobile

1. In SMART Mobile, go to Settings and click Report a Bug
2. Write a brief description of the bug and click the Save check mark
3. SMART Mobile will create a zip file with the bug report (including details about your SMART Mobile configuration) and place it in a new folder called “/SMARTdata”

If you need assistance with using SMART mobile, please contact the SMART Program Manager (smartpm@smartconservationsoftware.org).

Exporting patrol data for sharing

After importing the SMART Mobile patrol data to SMART you will export the patrol to a separate folder in your computer which you may need to do to share data between computers:

1. Create a folder in your computer with the name of your team-SMART Mobile equipped device or phone number-date of patrol. Example: RukwaLuafi1-BVG2-21April2020.
2 Open the SMART software \click on **Patrol** on menu bar \click on **Export Patrols** \select the **patrol** or **multiple patrols** you want to export from the drop-down list by clicking on them (a tick mark will appear in front of the selected patrol) \click on **Browse** \Select the folder you created (Example: RukwaLuafi1-BVG2-21April2020) \Click on **OK** \click on **Export**.

3 The patrol data may be shared via USB or email with data manager for importing into another SMART database.
Field exercise: Data collection using SMART Mobile equipped devices

- Divide into teams to conduct a practice patrol around the training site
- Collect data on the handheld devices; record the patrol configuration, then start taking observations at simulated crime scenes
- Try to be vigilant and observant, especially for signs of human activity, wildlife, and features. Also record the start and end of a patrol, and any changes in movements of the patrol teams such as rest stops or change of transportation (foot to vehicle, vehicle to foot etc.)
- When the patrol is finished, import your data to SMART via the SMART Mobile or CyberTracker field data interface. Compare patrol results between teams.
Using SMART for adaptive management; tasks for the data collector

As mentioned in [Section 1], SMART is designed to help improve the protection of conservation areas through streamlining the conversion of field data collected by rangers into information on human activities and threats to wildlife that can be used for strategic planning. For this process to work, a SMART database should receive regular updates and be managed effectively. The data manager plays an important role in making sure that data and information flows happen. The key tasks are described below:

1. **Ensure data are collected** - Patrons should be conducted on a regular basis to ensure protection and monitoring activities and associated data flows. Patrons can be scheduled for each team, station or planned by using the Planning Module in SMART (see: SMART Technical Training Manual: Module 6: Planning and Intelligence).

2. **Ensure data come in on time** - There should be a directive for what happens to the data once patrol teams have brought in their devices from the field. A responsible person should be assigned to upload data to the SMART database. Patrol data should be entered as soon as possible after patrols are completed so as to ensure that events requiring action such as poaching, encroachment, harvest of wildlife or other resources or other illegal activities are quickly brought to the attention of the manager. This should be done as a part of the routine debrief process for patrols, so data can be reviewed, corrected and input together with the team who collected the data.

   - If data are being transferred manually or where SMART Connect is deployed but connectivity is limited or absent, a system should be set in place to ensure regular transfer of data from the field to the data manager. For example, waypoints, tracklogs and field forms may be submitted to the data manager within a set timeframe.

3. **Ensure data a correct** - Data needs to be checked for quality and accuracy by the data manager before it gets incorporated in basic analysis (queries and summaries) and appears in reports. At the end of each patrol a debrief should be done with the team collecting data. The debrief should involve the following steps;

   - Verbal report from the patrol leader to his/her supervisor on the patrol including patrol objectives, patrol mandate, team composition, route of travel, major results (wildlife, threats encountered, actions taken)

   - Upload the data to SMART and run the quality assurance tool on the data. Further information on how and what to check for, as well as how to use the SMART Quality Assurance tool, can be found in the SMART Quality Assurance Module Handbook.

4. **Ensure feedback from the manager is followed up on** - Further considerations for adaptive management under the SMART approach are discussed in the SMART Adaptive Management Training Handbook.
Features

Projects

- Projects are the survey or patrol configurable models packaged for use with SMART mobile
- Multiple projects can be installed with their own maps and settings
- Customizable project icon

Support for Patrols, Surveys and Independent Incidents

- Different configurable models run at the same time
- Possible to select a “Survey” or “Patrol”

Export data to SMART Desktop

- Data can be exported to a format that can be imported directly from the device into SMART desktop

Upload data to SMART Connect

- Upload data the SMART Connect server when online
- No data are lost if offline

**Multi-language data model support **

- Support for multiple languages if configured on SMART desktop

Time correction

- Automatic UTC time zone detection
- Automatic daylight saving detection

Data entry

- Selecting data model with icons
- Lists with icons
- Trees with icons
- Pictures which are automatically rotated and scaled
- Composite sightings at the same location
- Trees can be flattened into lists

Patrols and Surveys

- Change metadata quickly during the course of a patrol
- Change metadata can have disabled attributes, e.g. “Armed” can only be specified when a patrol is started

Independent incidents

- Entry during patrol without losing what was being done
Sighting history

- Summary views of patrol sightings and independent incidents
- Detail view of individual sighting
- Editing past sightings without interfering with the patrol (can be disabled)
- Picture view for previously captured pictures

Kiosk mode

- Allows the device to be locked for SMART Mobile use only
- Customizable exit pin

Track timer

- Customizable by distance

Alerts

- Send data based on matching sighting attributes
- Configurable from SMART desktop

Pings

- Send a position at timed intervals
- Configurable from SMART desktop

Maps

- Visualize the SMART basemap
- Visualize observations, incidents and tracks
- Offline maps overlaid on base map
- 10 online base maps: OpenStreetMap, National Geographic, Satellite, Oceans, etc.
- Layers can be turned on and off
- Inspect
- Navigation with realtime pointer
- Compass
- Satellite view
- Smooth panning, pinch-zoom and rotation
- Rotate to north at top button
- Follow modes: user, follow, navigation
- Co-ordinates in decimal degrees, degrees minutes seconds, degrees decimal minutes and UTM

Settings

- Font scaling (100%, 125%, 150%, 175%, 200%)
- 100+ languages for UI
- Dark mode
- Full screen mode
- GPS simulation with customizable routes
- Theme colors

**Icons**

- Color, gray scale, or black and white
- 200 common core categories and attributes
- 250 wildlife species icons associated with species in the default data model
- More to come in future
- Users can add their own icons

**Other**

- Create bug report
- App can be killed/crash without losing any state
Frequently Asked Questions

On which types of patrols should there be data collection?
ALL patrols should have data collected. Regardless of objective (e.g. law enforcement, surveillance, tourism) or transport types (e.g. foot, boat, motorbike, car, roadblock).

Which observations should be recorded?
All observations that fall under the categories in the data model (e.g. signs of wildlife live and dead, human activity, natural features) should be seen as a priority to record. Consider the needs, threats and objectives of the protected area and how the data collected will be used (i.e. adaptive management, research, etc.). Each site should detail the data collection procedures relating directly to the needs at the site.

What handheld devices/smartphones should we buy for our protected area?

General Considerations

Each site is unique and therefore it is difficult to prescribe a specific device to suit all needs. However, we recommend SMART users consider the following before selecting the device they wish to use and consulting the SMART Community Forum for advice from other users. **Tip:** It is recommended that sites try to standardize the devices they are using, to avoid conflicting or variable results.

1. **Ruggedness:** How much abuse will the device take from its users and how wet and/or dusty is the environment the devices will be used in.
2. **GPS sensitivity:** How difficult is it to get a GPS reading in the environment in which they will be used? Some devices are better at dealing with tree canopy, cloud, terrain, etc. than others.
3. **Form factor:** Device size, screen size, weight, etc. Larger screens make text entry easier and help to prevent inadvertent selection of incorrect choices in lists. The advantages of larger devices and screens must be weighed against their increased power requirements and bulkiness. While there are many ruggedized tablets on the market, this discussion focuses on devices that are similar in size to smartphones or PDAs, under the assumption that tablets will be too bulky for most rangers to carry in the field.
4. **Battery life:** How long must the devices be used in between charging? This is highly dependent on how the devices are used, i.e., how many observations are recorded each day, what is the frequency of track log point collection, how detailed are the observations being recorded (lengthier entries require the screen to be on longer and using the screen is one of the major sources of power consumption). Also, especially at sites where power fluctuates, battery failure is one of the most common causes of device problems. Many mobile devices nowadays have built-in batteries that cannot be easily changed, meaning that when the battery goes bad, they have to be returned to the manufacturer for service or replaced.
5. **Operating system:** SMART can be locked to run in kiosk mode using the installation process described above in section 3.4.2.

What should we do if SMART Mobile/CyberTracker device stops working during a patrol?
It is best practice to always have a backup. Collect data using GPS and datasheets/notebooks as well whenever possible. Note down when the device stopped working.
What should we do if GPS battery dies?
As above. Keep collecting data – ensure to write down the date and time of observation. Carry on patrol as normal.

What should we do if we run out of datasheets?
If you have a notebook, you can make notes, or use the back of the datasheets to collect data. Try to ensure the same information is recorded. Carry on patrol as normal.

What should we do if the camera stops working/battery becomes flat?
If you have a phone with you that takes photos, you can use that. If not just carry on your patrol as normal and describe the observations as best as possible using comments and/or during the patrol debrief.

I’m running SMART on a Mac computer but cannot import patrols from CyberTracker, why?
The desktop application of CyberTracker is only available for the Windows OS, meaning that the import or export of Patrol/Survey Configurable Models or data collected from the field cannot be currently done on a Mac OS or Apple computer not running Windows.

My Android device will not connect to my computer and I can’t install CyberTracker/import patrols, what can I do?**

1. Make sure the device is plugged into the computer and enabled to ‘Transfer Files’. To do this, swipe down on the top of the screen and change from ‘USB Charging’ to ‘Transfer Files’. - This is a common issue with getting the .apk file for CyberTracker for the first installation.

2. With the device plugged in, ‘Export the Patrol Configurable Model’ to the device, the first time, you should get an error message saying that Before CyberTracker can be used it must be installed on the device.

3. Check the ‘File Manager’ for the .apk file. It should appear near the bottom of the Internal Storage window. Here, you will need to give the device permission to open the file.

4. Once it is installed, you can resend the Patrol Configurable Model to the device and it should work. If the device has been disconnected, follow Step 1 again.
Android settings and troubleshooting SMART Mobile

For most SMART Mobile users we recommend turning off advanced location features, as these “high accuracy” setting are often less accurate in the places we work.

Below are details on how to set you phone to use GPS only location settings based on [this guidance from Google].

**Android 10**

1. Open your device’s Settings app.
2. Tap Location.
3. Tap Wi-Fi and Bluetooth scanning.
4. Turn both Wi-Fi scanning and Bluetooth scanning to off.
5. Go back a screen
6. Turn Emergency Location Services off

**Android 9**

To change location settings:
1. Open your device’s Settings app.

2. Tap Security & Location
   • If you have a work profile, tap Advanced.

Then

• Turn Location on. Tap Location.

• Scan for nearby networks: Tap Advanced Scanning. Turn Wi-Fi scanning or Bluetooth scanning **off**.

• Turn emergency location service on or off: Tap Advanced Google Emergency Location Service. Turn Emergency Location Service **off**.

**Android 6.0 – 8.1**

1. Open your phone’s Settings app.

2. Tap Security & Location. If you don’t see "Security & Location," tap Location.

3. Tap Mode.

4. Then pick: **Use only GPS**. Don’t use Google Location Services to provide location information. This can estimate your phone’s location more slowly and use more battery.
Set the location mode to device only

- Other suggested Android general settings
The SMART Partnership is a group of global conservation agencies, conservation organizations, and individuals that share a mission to conserve biodiversity, reduce the impacts of illegal extraction and trade of natural resources, strengthen law enforcement related to biodiversity conservation and strengthen overall management of conservation areas.

SMART Values

- Freely available and open source
- Responds to needs and feedback from front-line users
- Scalable and customizable to a wide variety of locations and contexts
- Packaged with an extensive support and training network
- Commitment to long-term funding and support through the SMART Partnership

SMART Partners
CONTACT US AT:

🌐 smartconservationtools.org
✉️ info@smartconservationsoftware.org
🐦 @SMARTCnsvTools
See 2019/20 SMART Annual Report

See ‘SMART competence register’ for full details.